Tutorial 2: Extrac¢dao de subconjuntos de dados imagem e transformacgoes de
coordenadas com cédigos EPSG

1. Obtencao duma imagem LANDSAT-8 do arquivo online EarthExplorer
Passo 1: Registo na plataforma http://earthexplorer.usgs.gov

1. Login 2. User Affiliation 3. Address 4. Confirmation

The USGS EROS registration service allows you to register and save information that can be used to access
a specific USGS site or to place orders for USGS products. Additional features, such as the ability to save
search information, may also be available to registered users depending on the site accessed.

To register, please create a user name and password. The information you provide will be secure and not
shared with others. Review our privacy policy.

Login Information

Password must be between § and 16 characters long, and contain at least one alphabetic and numeric

character.

Username: [| You may wish to
use your email
address for your
user name.

Password:

Confirm

Password:

[ 4]
[ 0]
[Type the text | Privacy & Terms
- Cancel || Continue :
Note: All fields are required.

Passo 2: Procura da imagem de interesse

1. Ir para o endreco web: http://earthexplorer.usgs.gov

2.

Definir a area de interesse. Esta pode ser feita utilizado a coluna (path) e linha (row) da imagem, um

ponto uma shapefile, etc. Neste caso temos interesse numa imagem de Coimbra cujas path e row
sdo respectivamente (204,32).

1. Enter Search Criteria

To narrow your search area: type in an address or place
name, enter coordinates or click the map to define your
search area (for advanced map tools, view the help
documentation), and/or choose a date range.
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3. Definir as data para as quais pretendemos procurar as imagens de interesse. No nosso caso temos
apenas interesse nas imagens dos anos 2013 e 2014


http://earthexplorer.usgs.gov/
http://earthexplorer.usgs.gov/

4. Definir os conjunto de dados que pretendemos pesquisar. Neste caso estamos apenas interessado
no landsat 8 (OLI)

El-Landsat Archive [ 1
| @ [E L8 oLITIRS

- (] @ [E] L8 OLITIRS Pre-WRS-2

- [ @[] LT ETM+ SLC-off (2003-present)

- [ @ [E] L7 ETM+ SLC-on (1999-2003)

= |l @@ L7 ETM+ Intl Ground Stations (Search Only)

- ] @ [ L4-5 T™ -

Clear All Selected Additional Criteria » m

5. Pressionar em Results e obteremos a pegada de 100 imagens que correspondem ao nosso critério.
Indo para a pagina 4 encontraremos a imagem pretendida

Entity ID: LCE2040322014190LGNOOD
Coordinates: 40.33258,-8.42609
Acquisition Date: 09-JUL-14

Path: 204

Row: 32

YddZLEO

Entity ID: LC&2040332014190LGNOO
Coordinates: 38 90437 -8.87423
Acquisition Date: 09-JUL-14

Path: 204

Row: 33

$ddZL E0

6. Adicionamos a imagem ao Bulk Download. Acedendo ao carrinho de compras (Basket)verificamos o
nosso pedido e submetemos o pedido

Bulk Download

Note: File sizes are approximate. Final file size may vary slightly.

L& OLITIRS 1 1 911.5MB
‘ Total Size: || 911.5MB |

Return To ltem Basket Submit Order

7. lIremos receber um email notificando-nos que o pedido se encontra disponivel

Passo 3: Descarregamento da imagem utilizando a aplicagao bda.

1. Descarregamos e instalamos a aplicagdo Bulk Download Application (BDA) 1.1.2 de
http://earthexplorer.usgs.gov/bulk/

2. Inicializamos a aplicacdo BDA e seleccionamos o pedido que descarregar

@ 0 Orders

Flease select an order.

Orders
|Order ID |Date Ordered ||Skatus

Sep 29,2014 Available

| Select Order | | Delete Order | | Cancel |



http://earthexplorer.usgs.gov/bulk/

3. Depois falta apenas inicializar o download da imagem (911.5MB) o qual podera demorar algumas
dezenas de minutos dependendo da velocidade de download que temos

@ — 0 Bulk Download Application
File Sattings View Help
Destination
) /mome/giljapps/bda/ B
Free Space: 63,680,384.0 KB (60.7 GB)

Downloads
Order 382682

Entity ID Product Data Set File Size Status
LCB2040332014190LGNOO Level 1 GeoTIFF Data Pr.. L8 OLITIRS 91156 MB Pending

Remaining: 1 scenes (911.5 MB) Errors: 0

Progress

gegin Download | | Clear Completed Downloads

Passo 4: Descompressao do ficheiro contendo as 11 bandas imagem (a banda *_BQA.TIF é uma imagem que
define a qualidade da imagem)

LC82040322013251LGNOO_B1TIF 121,5MB Image Fevé
LC82040322013251LGNO0O_B2TIF 121,5MB Image Fevb
ilEd LC82040322013251LGNOO_B3TIF 121,5MB Image Fevé
LC82040322013251LGNOO_BA4TIF 121,5MB Image Fevb
LC82040322013251LGNOO_BS5TIF 121,5MB Image Fevé
LC82040322013251LGNOO_BG6TIF 121,5MB Image Fevb
ilEd LC82040322013251LGNOO_B7TIF 121,5MB Image Fevé
LC82040322013251LGNOO_BBTIF 4856MB Image Fevé
LC82040322013251LGNOO_BSTIF 121,5MB Image Fevé
LC82040322013251LGNOO_B10TIF  121,5MB Image Fev6
jiEl LC82040322013251LGNOO_B11TIF  121,5MB Image Fevg
LC82040322013251LGNOO_BQATIF  121,5MB Image Fevg

LC82040322013251LGNOO_MTL.Ext T, 7kB Text Fev 6

2. Extraccdo duma area de estudo’

Passo 1: No QGIS os sistemas de coordenadas sdo identificados pelos seus cddigos EPSG, os quais podem
ser consultados em (http://mapas.igeo.pt/igp/epsg_codes.html). Neste caso basta carregar os dados
geograficos pois o QGIS consegue identificar os sistemas de coordenadas e efectuar a transformacao de
coordenadas respectiva, desde a opgao - Habilitar automaticamente a transformacdo “on the fly” - estiver

activa
® © Opgdes .
» - Sistema de Referéncia de Coordenadas (SRC)
A Geral
23 SRC predefinido para novos projetos
"
'{Qe Sistema

B Habilitar automaticamente a reprojegao 'on the fly' se as camadas tiverem diferentes SRC

=| Origem de dados = . .
= 2 Habilita reprojecao "on the fly' por defeito

\(/ Renderizacao Inicie sempre um novo projecto com este SRC
El Janela & Legenda EPSG:4326- WGS 84 | Selecicne... |
I Ferramentas de

mapas. SRC para novas camadas

F= Far Quando uma nova camada & criada, ou quando uma camada é carregada e n3o tem SRC (Sistema de Referéncia de
I Digitalizar Coordenadas)
e s

@0 CDAL Prompt para SRC
GDAY

) Utilizar SRC projecto
@ utlilize SRC padrao mostrado abaixo

EPSG:4326 - WGS 84 | Selecicne... |

| Ajuda | Cancelar, | |

'0s dados para este exercicio podem ser descarregados de http://www.mat.uc.pt/~gil/downloads/Lab1.zip



http://mapas.igeo.pt/igp/epsg_codes.html
http://www.mat.uc.pt/~gil/downloads/Lab1.zip

Passo 2: Para cortar o conjunto de dados utilizamos a funcdo Cortador disponivel em >Raster > Extraccao.
D R s sreeRPLARR
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Camadas B

v [& 9 clip_cLoept

» [ " L71204032_03220000624_B10

Ficheiro de entrada (matricial) | L71204032_03220000624_B10 v | Selecionar...
Ficheiro de Saida amota/AulasPraticas/Tutorial2/ExtractoB10.tif M
Camadas | Navegador ] valor NoData
Ferramentas de Processamento i) Modo de cortar
Pesquisa ) Extensdo @® Camada de mascara
v Algoritmos utilizados recentemente Camada de mascara Clip_CLO6pE v | | Selecionar...
@ Save selected features —_—

@ Polygon centroids [ Criar uma banda alpha de saida
‘w rbuffer - Creates a raster map ...
& Unsupervised KMeans image ...
a Images Concatenation
a Dimensionality reduction appl...
» $3 GDAL/OGR[15 geoalgorithms]
» & GeoServer/PostGIS tools [8 geoal...
> ' GRASS commands [152 geoalgorit...
> & Models [12 geoalgorithms] crop_to_cutline -of GTiff
» @ Orfeo Toolbox (image analysis) [7... /media/Gil16/Aulas/DeteccaoRemota/AulasPraticas/Lab1/L71204032_03220000624_B10T1
» # 0GIS aenalaorithms [58 necalaari i F /media/Gil16/Aulas/DeteccacRemota/AulasPraticas/Tutorial2/ExtractoB10.tF
| Advanced interface =)

[ Carregar no mapa quande concluido

4 adalwarp -q -cutline
4 | /media/Gil16/Aulas/DeteccaoRemota/AulasPraticas/Lab1/ClipCLO6pE/Clip_CLOGpt.shp -

&

|
1 Ajuda | Fechar | | OK |
597712,4507688 Esci . - =

375428.97,4351799.25: 708471/Q§| Coordenada:

Dado que a fungdo Cortador ndo utiliza o envelope da shapefile (isto é o rectangulo definido pelos pontos

(Xmin,Ymin) e (Xmax,Ymax)) a imagem resultante terd um conjunto de pixeis cujos valores serdo 0 (estardo
com cor preta).

Para solucionarmos este problema é necessario extrair da shapefile o seu envelope. Podemos utilizar para

esse efeito um dos algoritmos disponiveis no QGIS, por exemplo em >Vector >Ferramentas de Investigacdo
>Poligono a partir da extensdo da camada.

S0 matricial Base de Dados Raster Processamento Ajuda

= Camada de entrada
OpensStreetMap . —
A Ferramentas de Anilise . | Clip_CLO6pL =
L Ferramenta de investigacao v g Seleccao aleatéria
{C} Ferramentas de geoprocessamento » & Selecio aleatéria dentro de subconjuntos
D Ferramentas de Geometria » 4 Pontosaleatorios "] usar apenas os elementos selecionados
2 Ferramenta de gerenciamento de dados v

..... Pontos regulares

Grelha vetorial | calcular a extensao de cada Funcionalidade separadamente
«~ Selecionar pela localizacao

Ficheiro shapefile de saida de poligonos

eccaoRemota/AulasPraticas/Tutorial2/fenvelope.shp | | Pesguisar |

] 0% Fechar | [“J
Indicamos o ficheiro shapefile de saida e aceitamos que o ficheiro seja adicionado a TOC (Table of
Contents).

Com este poligono utilizamos a funcdo Cortador explicada anteriormente para cortar cada uma das bandas
da imagem de satélite.

Para evitarmos repetir este processo para cada uma das bandas podemos utilizar um raster virtual
composto pelas bandas que pretendemos utilizar:



1. Comecamos por carregar na TOC as bandas que pretendemos utilizar, notando que a resolucdo
espacial das bandas é diferente entre elas. A ordem em que elas aparecem no TOC é também
importante pois desta forma saberemos a ordem pela qual elas irdo aparecer no extracto.

2. Depois seleccionamos o algoritmo Construir Raster Virtual em >Raster >Diversos

»5 Processamento  Ajuda 5 =
;i Projeces e @ 8 = v B

Conversao r
a  Extracao . fa@% R V .
,F [+ @2% £
Andlise ki

Diversos

Configuraces do GdalTools _L"" Juntar
i} Informacao
i', Construir reducdes (Piramides)

2% indice de quadriculas

3. Seleccionamos as camadas visiveis e atribuimos ao ficheiro final a menor resolugdo (isto é 30
metros) e seleccionamos que pretendemos as bandas separadas.

900D Quid £u.1-Durour

NEEBBELR O 2o mRNDE oo WE . .06 = »

() Construir Raster Virtual (Catalogo)

Y @ ap = {

-7 B R e x g = E

Camadas ® [ utilize as camadas raster visiveis como dades de entrada
» [ " L72204032_03220000624_B8O

& " L72204032_03220000624_BT0 Ficheiros de Entrada
& " L72204032_03220000624_B62
& " L71204032_03220000624_B61
[ [" L71204032_03220000624_B50 & Resolucio [ enor =

>

> = -
" Ficheiro de Saida Jmedia/Gil16/Aulas/DeteccaoRemota/AulasPraticas/Tutorial2/Extracto.vrt Selecionar...
s -
» [ " L71204032_03220000624_B40

>

>

>

v

ki ] NoDatanaFonte |0

& " L71204032_03220000624_B30

& " L71204032_03220000624_B20 & separar
& " L71204032_03220000624_B10 71 Permitir diferencas na projecao
& = envelope
. [} Carregar no mapa quando concluido
gdalbuildvrt -resolution lowest -separate /media/Gil16/Aulas/DeteccaoRemota/AulasPraticas/ Tutorial2/Extracto1.vrt w
Camadas | Navegador ,’media,‘cih6,1‘Aulas,fDete(canRemota,’AulasPraticas,lLaM,’L72204032_03220000624_380.T|F
,’med!alc!h6,#'Aulas,r‘DeteccaoRemota,"AuIasPrat!cas,iLaM;’L?ZZO#DSZJSZZOOUOGZ{B?O.HF G
Fi tas de P b & fmed!afC!H6,"Aulas,r‘DeteccaoRemota,’AuIasPrat!cas,iLab1;’L72204032 03220000624_B62.TIF
Framenas peuesamen 2 [media/Gil16/aulas/DeteccaoRemotafAulasPraticas/Lab1/L71204032_03220000624_B61.TIF
Pesquisa. /media/Gil16/Aulas/DeteccaoRemota/AulasPraticas/Lab1/L71204032_03220000624_BS0.TIF
= [media/Gil16/Aulas/DeteccaoRemotafAulasPraticas/Lab1/L71204032_03220000624_B40.TIF
> & GRASS commands [152 geoalgorit... =~ {media/Gil16/Aulas/DeteccaoRemota/AulasPraticas/Lab1/L71204032_03220000624_B30.TIF
> o Models [12 geoalgorithms] [media/Gil16/Aulas/DeteccaoRemotafAulasPraticas/Lab1/L71204032_03220000624_B20.TIF
» @9 Orfeo Toolbox {Image analysis) [7... . [media/Gil16/Aulas/DeteccaoRemota/AulasPraticas/Lab1/L71204032_03220000624_B10.TIF

v ﬁ QGIS geoalgorithms [58 geoalgori...
b Raster tools
» Vector analysis tools
» Vector creation tools
¥ Vector general tools —_— 7 [—
% Delete duplicate geometries ~ &J lEK—hMJ -

[:u;vanced interface = J

389776.08,4351799.25 : 694121.92,4578000.7(§] Coordenada: 407874,4490810 Escala [1:1554427 | v | (8 @ Desenhar EPSG32625 (@

4. Depois utilizamos este raster virtual no cortador raster indicando a madscara o envelope
previamente definido.



@00 osis201-bufour

™ @R MmE e e ®TDD Q ~ o e B ke
0 NS 2L RAPLRKLS @& kv e & B L

X & -musEe LYR%AR®
camadas 8"

& & Extractor

Camadas | Navegador

Ferramentss e Processamento ®

v Algoritmos utilizados recentemente
& Polygon centroids
{ rbuffer - Creates a raster map
€ Unsupervised KMeans image
& 1mages Concatenation
€ Dimensionality reduction appl.
# Polygon from layer extent
» & GDAL/OGR 15 geoalgorithms]
> &l Geoserver/Postais tools [8 geoal
>  GRASS commands 152 geoalgorit... ~

Advanced interface ]

& coordenada: 548410,4418018 Escala [1:397771 | v | (@) @ Desenhar @

Note-se que o extracto representado na figura anterior foi obtido a partir do envelope da shapefile
projectada no mesmo sistema de coordenadas da imagem (observe-se que o rectdngulo esta
perfeitamente alinhado com a imagem). Para projectar a shapefile num outro sistema de
coordenadas basta seleccionarmos no TOC a shapefile e com o botdo direito do rato gravarmos o
ficheiro num outro SRC.

Digitalizacao duma area de estudo de interesse

Passo 1: Criacdo da shapefile do tipo poligono, utilizando o botdo . Neste passo é importante que o
sistema de coordenadas seja 0 mesmo da imagem (no nosso caso o EPSG:32629)

@ O NewVector Layer

Type
Point ) Line @ Polygon
File encoding
System =
EPSG:32629 - WGS 84 [ UTM zone 29N

Specify CRS

\ J

New attribute

Name
Type | Textdata =

width |80 Precision

Attributes list

MName Type width Precision
id Integer 10

Help Cancel OK

Passo 2: Instalagdo do plugin

@ 0 Plugins|All(220)

;'{‘&{ All Search |numer

g4 Numerical Vertex Edit

; NumericalDigitize

Digitize with just the keyboard

4 rating vote(s), 19819 downloads

Tags: digitizing
More info: homepage tracker code repository

Author: Cédric Mari

Available version: 0.2.0 (in QGIS Official Plugin Repository)

Install plugin

Help Close




Passo 3: Introducgdo dos valores numéricos da area a digitalizar

@ 0 Add numerical Feature

Add a numerical feature:

| X b
1 464000 4330700
2 .464000 4388000
3 .496000 4388000
4 .496000

Coordinates are given
() inthe CRS of theProject

@ inthe CRS of the Layer

Cancel l 0K J

Passo 4: Clip da imagem utilizando o clip (cortador) e definindo como masklayer o rectangulo digitalizado
anteriormente.

-

@ -0 QGIS 2.4.0-Chugiak
DEERLR S A2LAHPLRAR @
"i;lj b e W

Layers &3]
v /' AreaSantacruz

& OpenStreetMap

Layers | Browser

Processing Toolbox ®

¥ Recently used algorithms
 Vv.voronoi - Creates a Voronoi
@ Vv.voronoi - Creates a Voronoi ...
ii Extract raster values to CSV
|B extract Raster Values 2CSV
!i Clip rasterDir
ii ClipRaster
> &2 GDAL/OGR [32 geoalgorithms] ¢
b ' GRASS commands [167 geoalgori...
P & GRASS GIS 7 commands [159 geo...
L4 ,_g_; LecoS (Landscape ecology statist...
bl Models [4 aenalaorithms] =

Advanced interface 2 e D £ 1726K by LMy

| coordinate: 648820,4476778 Scale (1743098 | v | [ Render EPsG:3zszs @) (4




Anexo: Sistemas de referéncia definidos no QGIS através de proj4.

Portugal Continental - Sistemas Globais

Cadigo Descricdo
EPSG: 4936 ETRS89/ Coordenadas Geocéntricas
EPSG: 4937 ETRS89/ Coordenadas Geograficas 3D
EPSG: 4258 ETRS89/ Coordenadas Geograficas 2D
EPSG: 3763 ETRS89/ PT-TMO6
Portugal Continental - Sistemas Locais
Cddigo Descricdo
EPSG: 4274 Datum 73/ Coordenadas Geograficas 2D
EPSG: 27493 Datum 73/ Hayford-Gauss
EPSG: 4207 Datum Lisboa/ Coordenadas Geogréficas 2D
EPSG: 5018 Datum Lisboa/ Hayford-Gauss
EPSG: 20790 Datum Lisboa/ Hayford-Gauss com falsa origem -
Coordenadas Militares
STRING Sistema de coordenadas Cadigo EPSG
etrs89 Geogrdficas ETRS89 4258
pttm06 PTTMO06 do datum ETRS89 3763
pttmO6mil PTTMO06 do datum ETRS89 (versdo militar) N/A
etrs89utm UTM-29N do datum ETRS89 25829
d73geo Geogrdficas Datum 73 4274
d73hg Hayford-Gauss datum 73 (IGP) 27493
d73hgmil Ha.)-/ford-Gauss datum 73 (IGP) + translaccao N/A
militar
dixgeo Geogrdficas Datum Lisboa - Elips. Hayford 4207
dixhg Hayford-Gauss datum Lisboa 20791




dixhgmil Hayford-Gauss datum Lisboa (militar) 20790
ed50geo Geogrdficas ED50 4666
ed50utm29 UTM 29-N Datum Europeu 1950 2963
dixbgeo Geogrdficas Datum Lisboa - Elipsoide de Bessel 4230
dixbb Sistema Bessel-Bonne (eixos invertidos) 23029
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